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1) INTRODUCTION & ACCESS LEVELS


Main page resources @ www.artstor.org:
· Terms and conditions of use link leads to quick guide for understanding how you can use images from ARTstor.  Can print out PDF of quick guide or whole agreement.

· Click on LAUNCH on the Right to start database.  ARTstor proprietary client will load and take over Browser window.

· Technical requirements needed on your terminal for ARTstor to work are listed at: http://www.artstor.org/info/using_artstor/techspecs.jsp.  If your computer does not have these requirements, please call the IS&T Help Desk.

Access:

There are three levels of access for ARTstor users.

Unregistered users

-No registration or logon is required 

-Able to search, browse and analyze images and data

-Able to open and view the contents of institutionally-shared folders


Registered Users

-Able to save Image Groups (past a single session, i.e. groups that are persistent and you can come back to another day) and personal notes (notes that you can add to the object records within ARTstor)

-Provided with 120 days of remote access to your ARTstor account

How to Register:
With email address and password (can use any email address, and password of your own creation).  Once registered, then every time you use ARTstor you just need to logon.
Instructors
-Able to create folders for sharing Image Groups with colleagues   
-Able to add shareable comments to images
-Can also upload your Personal Collection of images to ARTstor  
-So, when you grant yourself, what are called “Instructor Privileges”, you gain access to the full functionality of ARTstor.

How to:
-Anyone who is Museum staff can give themselves instructor privileges
-Under the “Tools” toolbar menu select “Obtain Instructor Privileges”

-Enter the access code and password that have been given to us as an institution:
Authorization Code:  awmfmetmuseum
Password:  artstor

Remote Access:
If you login to ARTstor within the Museum’s IP range, then you will be granted remote access to ARTstor for 120 days following.  During those 120 days you will be able to access ARTstor from a computer anywhere in the world with your account.  

1) Simply go to http://www.artstor.org
2) When you click on the “Launch” link in the lower right corner of the page, a new window will popup, prompting you to enter your ARTstor email address and password.


From the ARTstor Welcome Page you can Browse or Search collections.

2) BROWSING

To browse a collection, simply click on the collection name from the Welcome page.  You will be taken to a collection page with a list of expandable categories.  Click on a category or subcategory title to browse images.  You can also browse ARTstor collections by clicking on the Collections button in the Thumbnail page.

N.B. ARTstor is in the process of adding images from the Scala Archives.  To search such images, run a keyword search on “Scala archives”.  ARTstor also expects to add images of Ghiberti’s Gates of Paradise by the end of February 2006.


3) SEARCHING (Keyword & Advanced)
a)  Keyword Search:

· A keyword search can be performed from the Welcome page or the Thumbnail page.  


· You can search across all collections or select a specific collection from the pull-down menu.


· A keyword search allows you to search by words or phrases that appear anywhere in ARTstor's object record (Title, Creator, Subject, etc.).  Please note that record fields are not standardized and may vary from collection to collection.  


· AND is the default Boolean operator.  E.G. A keyword search on Monet poplars will return image records that have both of these words somewhere in the record.

· {OR searches are available in the Advanced Search but can also be used in Keyword Search.  (When in doubt, use the Boolean operators provided in the Advanced Search.)}

· Use Quotation Marks to search for a phrase.  E.G. “Camera degli sposi”.


· Wildcard & Truncation Symbols:  
· *  Use the asterisk to truncate a word.  It will look for zero, one, or several characters.  

 E.G. 

 wom*n will return records with the term woman or women.  
 Brueg*l will return records with Brueghel or Bruegel.  
                                  
 Ital* will return records with Italia, Italy, Italian, Italianate, 

 etc.


· The underscore (_) can represent any one character:

E.G.  m_net will match "monet", "manet", etc.
b)  Advanced Search:

· You can search across all collections or specific collections using the Advanced Search interface.  Use CTRL + click to select multiple collections.  

· Choose which record fields you would like to search by using the drop-down menu on the right.  Please note that record fields are not standardized and may vary from collection to collection.

· Choose Boolean operators (And, Or, Not) from the drop-down menu on the left.


Sample Searches:  

Search for Watteau as Creator and Judgment of Paris as Title.  





Search for Bodhisattvas in Title and silk in Material.  Select 

Dunhuang Archive collection.

· Searching Notes and Comments:  

If you have added notes or commentary to image records that you have saved, it is possible to search the text of these notes.  N.B. It takes a few hours for new note entries to appear in the search results.  

4) DISPLAYING, SORTING & CLUSTERING RESULTS

After running a search, your results will be displayed in a Thumbnail mode, displaying a thumbnail with title and creator information in the caption.  You can also display results in a List Mode, which displays additional information and a slightly larger thumbnail.  

To switch the display mode:
1) After running a search, or when browsing a collection, click the View Button in the Toolbar.  

2) From the drop-down menu choose “Display images in List Mode.”

3) Use the vertical scroll bar on the right, to scroll through the images displayed on the page.  Using the forward and back arrows at the upper-left, page through the additional lists of images.
You can SORT your results, in either Thumbnail or List Mode, by Creator/Artist or Title.  Under the “View” menu , select “Sort Displayed Images by …”.


Clustering:
ARTstor has begun clustering duplicate images.  The image that is the first within the cluster, and hence connoted as the authoritative copy, is either a Museum contribution, or an image that is determined to be empirically better than other copies of that image residing within ARTstor.  To view all copies of an image, click on the + sign next to the image in your results list.

5) VIEWING OBJECT DATA
Sample Search:  unicorn tapestry – Met contribution, good data.
You can view full information about an object, by clicking the “Full Record” link next to an image in List Mode, or by double-clicking the caption text underneath the thumbnail image in Thumbnail mode.  A new window will open with the object data (e.g., creator, title, location, etc).  

The Image Properties tab contains information on the digital file, i.e. the Media Data. You will find information like Image ID, Format, File Name, Width, Height, and Image URL. {This tab will also mention the collection that contributed the digital file, e.g., UCSD (University of California at San Diego Slide Collection).}  By double-clicking in the field titled "Image URL", you can select a stable URL for the image that you are viewing.  You can then copy and paste that URL directly into a browser, or send it as an email to someone else within the museum.  When the person receiving that email clicks on the link for that URL, they will be taken directly to the large resolution image, displayed in the Image Viewer.
The Instructor’s Commentary tab provides a space for you to add notes to an image file.  (You can only do this with Instructor Level privileges).  These notes can later be searched in the Advanced Search interface by users who are registered to access the folder that contains this image.  If you do not want your commentary to be viewable, check the box next to “Hide Commentary” on the bottom right.   

The Personal Notes tab provides a space for you to add notes to an image file for personal use.  These notes can only be viewed and searched by you.  
6) USING THE IMAGE VIEWER

Double clicking on a thumbnail will open an enlarged view of the image in the Image Viewer.  The Image Viewer provides you with tools with which you can zoom in on details, pan to different sections, and rotate the image 360 degrees.  (It also has tools for printing and saving images).  You can also use the viewer to proceed sequentially through a presentation.

1) Double-click on a thumbnail to open it in the Image Viewer. 
2) + - zoom in-zoom-out buttons:  
Analyze the image by single-clicking to zoom in and out on details using the “+” and “-” buttons.  N.B. You are not clicking into the image with this function, but are only using the + sign to keep zooming in on ONE FIXED PLACE.  (When zooming in, wait for the image to resolve itself – Progress bar shows up on top.)
3) Panning: (multidirectional button)
Once you’ve zoomed in as much as you want, select the PAN function to click and drag around the image.  You can also click and drag the little red square in the bottom window, which tells you what part of the image you’ve zoomed in on.  (When panning, wait for different sections of the image to resolve themselves – Progress bar shows up on top.)
4) Rotating:  
Rotate the image using the circular arrow button and clicking and dragging around the image.
5)  Reset Button:
      Resize the image to fit the viewer by clicking the Reset button to the right of the    

      zooming buttons.  This restores the original image.
6)   ZOOM MODE:  (Default mode when you launch viewer)
This button allows you to click into any part of the image and magnify it.  You 

can either click into a single area, (but then you have to click multiple times 

before you get to 100% magnification.), OR, you can click & drag, i.e. left-click 

and while holding down the left-side of your mouse, click and drag to select the

area you’d like to magnify.  (This immediately brings you to 100% magnification 

of that selected area).  Can then use Pan tool to move around the image at that 

level of magnification.  
Other Image Viewer Functions:
(If you don’t see these icons you need to make ARTstor a trusted site.  Please contact the IS&T Help Desk).


· Printing from the Image Viewer:  Use the print icon on the bottom left of the Image Viewer window.  The printout contains the image, descriptive information, and a copyright statement.

· Downloading/saving from the Image Viewer:  Use the download icon on the bottom right of the Image Viewer window.  You will then be prompted to accept ARTstor’s Terms and Conditions of Use.  After clicking “I accept” you will be prompted to install and run a signed applet distributed by ARTstor.  You will then be able to download images onto a local disk or desktop.  If you have zoomed in on part of an image, you can save that detail as well.  

An ARTstor image gets saved as a JPG, and the object record gets saved as a separate HTML file.  It’s best to keep the ARTstor filename when saving the image, and only rename it after it’s been saved.  

N.B.  Your image will download as a low resolution JPEG file, at approximately 384 pixels on the long side.  In order to download higher resolution files of ARTstor images (up to 3200 x 3200 pixels), you must download and view them in the Offline Image Viewer.
(  “I” icon:
Clicking on this icon will open the data window in the Image Viewer.

      (  Maximize/Minimize icons:

You can maximize and minimize the Image Viewer window.

      ( Title List:

           You can view the list of other images in your results set or saved image 

            group by clicking any title from the list to jump to that image.  That image  

            will then load in the Image Viewer.
      (  Hide caption information:

This is the caption (title/artist) that appears in the lower left corner of the 

image viewer.  Faculty use this feature when they are trying to test 

students, etc.
(  Navigational arrows at bottom of Image Viewer:
      You can move to the next or previous image within your results or image     

       group by using these arrows.  The image will open up in the Viewer.  

      (You can also jump to the first or last image within a group, but to jump to   

      any image, out of order, you have to use the Title List icon).

7) SIDE-BY-SIDE IMAGE COMPARISONS
You can view two high-resolution images at the same time on the screen for comparison purposes.  Simply double-click on the image thumbnails and they will each open in the Image Viewer at half-screen.  Arrange your two Image Viewer windows on the screen.  Both windows can be moved or minimized.  Now you can perform actions (zooming, panning, etc) in each of the viewers, and on each of the images, separately.
8) SELECTING IMAGES

To select an image, click once on a thumbnail.  The selected image will be framed in yellow.  To deselect an image, click again on a selected thumbnail.  To clear all your selections choose “Deselect all selected images” from the View menu in the top toolbar.

9) CREATING IMAGE GROUPS

1)  Select images by single clicking on each one you want included in a group.  Note: If 

you run a search and select images from your search results, those images will remain  selected even if you do another search.  All selected images will be saved to the group.

2)  After selecting your images, click on the "Image Groups" toolbar button.  The 

resulting drop-down menu will display two options for saving images: "Save selected images to new group" or "Append selected images to existing group."  Use the first option to create a new group with the images that you have selected.  Choose the second to add your selections to a group that you have already created.  Whichever option you choose, a new dialog box will open.  This dialog box will be the same for both options. The only difference is that the "Create new group" or "Append to group" radio button at the bottom of the window will be pre-selected depending on which option you choose.  (You may always select a different radio button once this window is open.) 


3)  Choose a folder in which to save your Image Group from the "folder" drop-down menu.  This may be a personal (private) folder; the system gives everyone a “Work Folder”.  It may also be a shared folder to which you have access.

4)  If you are creating a new group, enter a name for your Image Group after double-clicking into the "Group" field.  If you are appending images to an existing group, use the drop-down arrow provided in the "Group" field to select the group that you already created.  Your new images will be saved to this existing group. 


5)  Click the “Save and Open” button. Your image group will open in the Thumbnail page, with the thumbnails listed in the order that you selected them.  


N.B.  It is possible to open an Image Group in a separate window.  After selecting a Folder and Image Group, check the box next to “Open group in separate window.”  Then click the “Open” button.  This feature allows one to easily compare the contents of two image groups.  You can then add images from one group to the other by dragging and dropping, or copying and pasting.  (To copy an image, select the image, right-click and select copy from the pull-down menu.  To paste, right-click on an image and select paste from the pull-down menu.)
10) CHANGING THE ORDER OF IMAGES
Once you have created an image group, you can rearrange your images by dragging and dropping.  The thumbnails are reordered on the screen through a “drag and replace” functionality.  

1) Click and drag a thumbnail over the image you wish to replace.  

2) Release the mouse.

3) The moved thumbnail will appear in the position of the replaced thumbnail.  The replaced thumbnail will move over to the right or left.

11) DISPLAY IMAGE GROUP IN SLIDE SORTER 

This option is available only when you have opened an image group with more than 15 thumbnails.  

From the "View" toolbar menu, select "View group in Slide Sorter".  This will bring up a new version of the thumbnail page which will display a thumbnail for every image in the group, but no image data.  Hence, rather than having to navigate through pages of images, you will be able to view thumbnails of all the images in your group on a single page.  You can also re-order your thumbnails in the Slide Sorter by dragging and dropping.  

12) OPENING IMAGE GROUPS:

Image Groups that have been created by Instructor level users and made public are available for everyone in the Museum’s IP range to view, even those that have not registered to ARTstor. 

From the Thumbnail page:
1) From the Image Groups menu, select “Open group.”

2) Image groups are saved within folders, so first you have to select a folder, then you can select an image group from that folder.

3) Click Open.  
From the Home (Welcome) page:
1) Click the Home button or the ARTstor logo to return to the Welcome Page.
2) In the upper half of the page under View Image Groups, click the dropdown arrow next to “Select a folder.”

3) After a folder is selected, click the dropdown arrow next to the menu below, titled “Select an image group.”

4) When both fields are selected, click “Submit” to open the contents of that Image Group.

13) DISPLAY IMAGE GROUP PRINT PREVIEW:

The Image Group print preview function allows you to review and print an entire Image Group.  This format offers thumbnail copies of the images in the group with choices for displaying the ARTstor data record, the Instructor Commentary, or any Personal Notes associated with the images.


1) Open an image group, and Select “Image group print preview” from the “View” toolbar menu.
2) From the menu choices, choose either “Full record,” “Brief record with commentary,” or “Brief record with personal notes.”
3) A new browser window will open, displaying the Image Group in the print preview format.

4) Select the browser printer icon from the new window to print a copy of the Image Group.

5) You can also select “Save as …” from the browser’s “File” menu to download the HTML file and images.

14) CREATING SHARED FOLDERS:  Sharing your image groups with colleagues
 
With Instructor Privileges, you may now create Shared Folders into which you can save Image Groups.  You can control the access that other users will have to these Shared Folders and Image Groups.



There are 2 types of access:

READ Access: Users are permitted to view, zoom, export and print the contents of the folder, but are not permitted to change anything.

WRITE Access: Users are permitted to create, delete, or modify the contents of the folder.

1) Under “Tools”, select “Create Shared Folder.”
2) Enter a name for the folder and click “Continue.”
3) You may either check the box to make this folder public, allowing it to be viewable by anyone at the Museum, or create access codes and passwords for READ and/or WRITE Access, which you may then distribute as you wish.  
4) You may also choose to create Work Folders where your colleagues can save Image Groups for your review and collaboration.  

15) MANAGING SHARED FOLDERS
After creating your shared folders, you may make changes to them.  ARTstor tools allow you to delete Folders or Image Groups, change folder titles or access codes, and change access levels, for e.g., from public to restricted.


1) Under “Tools”, choose “Folder Administration.” 

2) Under the “Folders/Groups” tab, delete a folder or an Image Group by selecting a name and then clicking “Delete” at the bottom of the column.

3) Click on the “Access Controls” tab.

4) Choose a folder from the list on the left side, then edit its title or accessibility options.

5) When finished, click “Submit.”
6) Click on the “Student Administration” tab.  You should get a list of users who are registered to access your folder.
7) To remove users from the access list for that folder, click the name, then choose “Delete.”

8) Double-click on a user’s name to add notes to their profile and view their e-mail address.

16) REGISTER TO ACCESS A SHARED FOLDER


1) If you would like to view the contents of a Shared Folder to which you’ve been given access, you will need to login to ARTstor.

2) Once you have logged on, go to the "Tools" toolbar menu and choose the "Access Shared Folder" option.


3) In the Shared Folder Registration form that pops up, enter your last name and first name, as well as the Password in the fields provided.  Click on the "Register" button to submit your registration. 

A confirmation message will appear, informing you that you have successfully registered to the named folder, as well as what type of access (read or write or both) you have been granted.  After you click "OK" in the confirmation message, you should see that Shared Folder listed in the "View Image Groups" drop-down menu on the Welcome Page.

17) PUBLIC INSTITUTIONAL WORK FOLDER


Every registered user in ARTstor is given a personal “Work Folder”.  This is a folder automatically set-up for every user by the system.  Its contents can only ever be viewed by that individual user.

There is also a public Institutional Work Folder, which is automatically created for each subscribing ARTstor institution.  Its contents can be viewed by anyone within the Museum.   This folder is entitled Metmuseum Work Folder.

· It is designed for a user with Instructor-Level Privileges who would like to share his/her Image Groups with the entire Museum. 

· An Instructor may elect to save Image Groups into the Institutional Work Folder, rather than creating his/her own public Shared Folders.  It is an additional option that ARTstor provides for Instructors who do not want to go through the process of creating their own Shared Folders, but would still like to share their Image Groups publicly.  Every user at a given institution will automatically have Read Access to any groups saved in the Institutional Work Folder. 
If you want to save images into the Metmuseum work folder, you have to:

a) Have Instructor Privileges
b) Register for Write access to the folder.  Go to Tools, and “Access Shared Folder”.  In the form, enter the password which is the same authorization code and password that you used to register for instructor privileges.  Combine the code and password together, and type the entire string into the password field as such:  awmfmetmuseumartstor
c) You will now be able to save image groups to this folder – it will appear as an 

      option when you save selected images.
18) PERSONAL COLLECTIONS

You can now upload your own local images to the live ARTstor database and search them as a collection alongside other ARTstor images.


Any user with instructor privileges can have his or her own online Personal Collection where images can be uploaded and added to ARTstor image groups already available to that user.  Personal Collection images can be cataloged and sorted into topics for easy retrieval.  Access to a Personal Collection can be restricted to an individual user, or to that user and others at the Museum.  (Please note that neither ARTstor nor the Museum is screening such content, and therefore the user is solely responsible for obtaining all necessary permissions before loading such images.)

Uploading images:


Local images can be uploaded from two locations; from the “My Personal Collection” page or from the Tools menu.  (Uploaded images need to be in either a JPG, JPG2000, GIF, Tiff, BMP, or PCD format.)  Each instructor-level user has 500 MB of storage space given to their account to hold their personal images, and can upload 5 images at a time.  N.B. By uploading an image to your Personal Collection, ARTstor makes a copy to store on their image servers, while your image file will be retained in its original location.
1) Click on the “My Personal Collection” collection title at the bottom of the Welcome Page.  In the Collection Page that opens, click on the “Personal Collection Image Upload” link in the lower left corner.  This option is also available from the “Tools” menu.

2) This will launch another window, through which you can begin uploading your personal images.  Depending on your institution, the tools in this window may be immediately active, or temporarily disabled until they are enabled by your local ARTstor contact.  If the tools are disabled, you will see the following message in the middle of the window: "To enable your Personal Collection, please contact your local ARTstor administrator: [contact information here]."  In this case, you will need to contact Deborah Vincelli (x2912) to get access to the Personal Collections tools.  Once you are enabled for access, you will be able to take advantage of the full functionality of this Instructor-Level feature from that point forward.
3) Click the “Browse” button next to File 1.


4) Find the image file you’d like to upload from your computer directory and click “Open.”


5) Click the “Upload” button at the bottom of the window.


6) You may continue to upload additional images or click “Cancel” to close the window or “X” out of the window.

Editing data:

Local image data can be edited to include any additional data required for cataloguing the image. {The basic data fields can be used, as well as a full list of possible fields based on VRA Core 3.0.}


1) While on the “My Personal Collection” page, at the lower-left corner, click “Personal Collection Administration”.  This option is also available from the “Tools” menu.

2) Double-click the name of an image file displayed on the right side of the page to edit the title.  (Just hit enter when you’re done typing the title).

3) Select an image by clicking on the title and click the “Edit Data” button at the bottom of the window to edit the basic data fields.


4) Click the “All Fields” button to display all available data fields.  Double-click into a field to begin typing text.


5) When finished, click the “Save” button.  (Remember to save changes before moving to next tab in this window.)  

N.B.  It may take several hours before the images that were uploaded and the data that was entered or edited becomes searchable within ARTstor.


Also note that the Image Properties tab will already be populated with media data, that is, information about the digital file, though you can also edit any of this data as well.  You can also add Instructor or Personal commentary to images in your personal collection to enhance the information in the data fields.  (This commentary then shows up in the Image Viewer along with the data fields when you click on “I”).


Setting image access rights: (3 levels)

Personal Collection images can be made either limited, partially limited (i.e. viewable to selected people), or Fully Accessible (within the Museum).


Limited Access:  The image will be viewable, searchable, save-able, and printable only by the Instructor-owner.  (Default option).
 
Selected Access:  For other users to view this image, the image must be included in an Image Group to which those other users have been granted access.  

Institutional Access: The image will be viewable, searchable, save-able, and printable by all users at the institution.  (“All users” meaning even if they are not registered users.) 

1) Within the “Edit Data” window, two buttons are displayed at the lower-right corner, “Limited Access” and “Institutional Access.”  (You can also avoid going to “Edit Data” by just right-clicking on the image title and seleting the type of access you want from the drop-down menu.)

2) Initially, all Personal Collection images are set by default to “Limited Access”.

3) To change the access from “Limited Access” to “Institutional Access”, or vice-versa, select the desired file and then click the appropriate button.


4) When finished, click the “Save” button.

You can also change the access level for your entire personal collection by:

1) Going to the “Personal Collection Administration” window.

2) Right-clicking on “Personal Collections” on the left side of the window and selecting one of these 2 choices from the drop-down menu:
a. Set categories/collections images to Institutional access

b. Set categories/collections images to Limited Access.


N.B.  A little green dot will appear next to those images that you’ve switched over to “institutional access”.  Even after you’ve made certain images “institutional access”, it may take a few hours before they are searchable within ARTstor by all users.  

Categorizing images:

You can create categories for the images in your Personal Collection.

1) Within the “Personal Collections Administration” window, click the “New Category” button at the lower-left.


2) A new category titled “New Category” will be added beneath the “My Personal Collection” heading.


3) To add subcategories, select the category it will fall under, then click the “New Category” button.


4) To rename the category, double-click on the title of “New Category” and type the new name.


Organizing Images:

After uploading personal images, they can be moved into the categories you have created in order to make them easier to manage.

1) Within the “Personal Collections Administration” window, your categories are listed at the left side below the heading “My Personal Collection.”


2) Click on “My Personal Collection” to display your current personal images on the right side of the window.


3) To copy an image from your Personal Collection into any of your categories, click to select an image title, and drag it over the name of the category into which it should be placed.  (All the images that you uploaded to your personal collection stay in that folder, and then it’s a copy that gets placed in the categories and sub-categories.  If you delete something from the categories, the original image is still in the Personal Collections area folder.)


4) When the image has been copied, click “OK” .


5) You can expand to view any sub-categories by clicking on the plus sign to the left of the category name and copy images into those as well.
Deleting Images:

Images deleted from the Personal Collection are moved into the Recycle Bin in case you need to get them back.  Images deleted from a category are deleted just from the category but remain in the Personal Collection.  To completely delete an image, delete it from the Recycle Bin.

1) Select an image from a category by clicking on it.  At the bottom of the right column, click the “Delete” button.  Click to confirm the deletion of the image.


2) This image has been deleted from the category only.  Click into the “My Personal Collection” and the image is still available here.


3) Select an image from the “My Personal Collection” and click the “Delete” button. Click to confirm the deletion of the image.


4) This image has been deleted from the library of My Personal Collection and any category it was associated with.  Click into the Recycle Bin, and the image now is only available here.

5) To empty the recycle bin and permanently delete all the images stored within, click on the category name “Recycle Bin,” then right-click with your mouse and choose the item “Empty Recycle Bin.”  Click to confirm the deletion of all the images.


6) To restore images from the Recycle Bin, click on “Recycle Bin” and then click on the image on the right side and select the Restore button.  (It restores it to the Personal Collection Library).


OTHER:

By Right-clicking on the LEFT SIDE of the “Personal Collections Administration” window, where your Personal Collections Library and categories are located, you get a drop-down menu with various choices; 2 important ones are:

1) Set categories/collections images to Institutional Access.

2) set categories/collections images to Limited Access.

By Right-clicking on the RIGHT SIDE of the “Personal Collections Administration” window, where your image titles appear, you get a drop-down menu with various choices; 2 important ones are:

1) Assign as lead image:
When you create a Personal Collection, it functions just like any other collection in the ARTstor Digital Library.  As such, ARTstor creates a Collection Page for your Personal Collection of images whose layout is identical to all other Collection Pages in ARTstor. In the left side of the screen, there is an "About the Collection" section, accompanied by a "lead image;" in the right-hand side there is a browsing hierarchy that you may enhance by creating categories and sub-categories.
 

If you do not specify a lead image for the area above the "About the Collection" section, ARTstor will display, by default, the first image in your collection.  You may also assign another image in your collection to be the "lead image," so that it summarizes the general tone of your collection, or represents a highlight of its contents. 

 

In order to set an image as the "lead image" on your Personal Collection Page:

1) Launch the "Personal Collection Administration" window.  

2) Once the "Personal Collection Administration" window opens, click on the "My Personal Collection" list item in the left panel. 

3) Locate the desired image in the list of image titles that displays in the right-hand panel.  Right-click with your mouse on the image title. 

4) In the shortcut menu that appears, select the option to "Assign as lead image."  As soon as you close the "Personal Collection Administration" window, this image will replace the previous one, so that the Personal Collection Page changes to reflect your new choice for the "lead image."

2) Upload a replacement image:  

This function allows you to upload a new image to replace an existing image in your Personal Collection.  You should consider this option instead of deleting the image from the Collection and then re-uploading it.  This is an especially useful option if you have already included the image in saved Image Groups.  Otherwise, you would need to find and remove the image from each group and then append the new image to remove the deleted image.  Also, using the "Upload a replacement image" option will preserve any data and/or commentary that you may have already attached to your existing image.

Deborah Vincelli  
02-06-2006
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